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1.0 Introduction 
 
MasterVerb is multi-algorithm reverb with a musical sound reminiscent of 
classic studio digital reverbs. 
 
MasterVerb features the following: 

 Two late reverb algorithms – Hall (for all sizes of rooms) and Plate (for 
super dense plate reverbs). 

 Early reflection section- halls, rooms, plates, chambers, echo, 
cathedral, nightclub, ping-pong. 

 3-band EQs for early and late frequency response adjustment. 
 Triggered envelope control for special effects such as gated and 

reverse reverb. 
 Ducking compressor ducks reverb during foreground sounds. 
 Beat synchronization options for delays and envelope times. 
 Graphical displays for EQ curves, time response, and 3-D frequency 

response. 
 Normal and detailed view modes. 
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1.1 Overview of interface 
 

 
 

 
Label Description 

 
Menu bar: Bypass, Undo/Redo, Presets, A/B buffers, View 
options, and Settings. 

 
Character control lets you quickly adjust the size and decay 
time of the space. 

 
Early damping 3-band EQ display, sets overall equalization of 
reverb. 

 
Late damping 3-band EQ sets frequency dependent decay 
times. 

 
Early reflection controls. 

 
Optional information tips. 

 
Envelope and Ducker enables and meters. The Envelope and 
Ducker are edited in the detailed view. 

 
Time response display diagrams the different components of 
the response and the Envelope. 

 
Frequency response display shows the time-frequency decay 
of the late reverb algorithm. 
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Output controls. 

 
Late reverb controls. 

 

1.2 Detailed View 
 
The detailed view can be selected in the View menu found in the menu bar. It 
provides Envelope, Ducker, and Modulation controls, and individual controls 
for the EQs. 
 

 
 
 
Label Description 

 
Early reflection controls. 

 
Frequency response display. 

 
This area shows either the time response or the EQ displays, 
depending on the controls the user is adjusting. 

 
Early damping 3-band EQ controls 

 
Envelope controls. 
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Ducking compressor controls. 

 
Late reverb controls. 

 
Late damping 3-band EQ controls. 

 
Output controls. 

 
Modulation controls. 

 

1.2 What’s new in MasterVerb 7 
 
Compared to MasterVerb 6, here are the major changes: 
 

 All new interface with dark theme. 
 Algorithm tweaks. 
 Beat synchronization options for delays and envelope times. 
 New ducking compressor. 
 Improved envelope processor. 
 Modulation controls. 
 Stereo width control. 
 New presets. 
 Optional info bar shows help tips for controls and presets. 
 Infinite undo/redo per edit buffer. 
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2.0 User Interface 

2.1 Character control 
 

 
 
The character control provides a quick way to adjust both the size and decay 
time of the space. Click/drag the control left-right to change the size, this 
adjusts both the late algorithm size and the early reflections. Drag up-down 
to adjust the decay time. 

2.2 Time response display 
 

 
 
The time response display diagrams the various components of the time 
response. The late reverb contour is shown with the shaded green region; it 
moves right with increasing wet delay, and the decay slope reflects the late 
reverb time. The bright green spikes represent the early reflections, they 
spread apart as the early size is increased. The white spike represents the 
dry sound, it will move to the right as the dry delay is increased, which lets 
the reverb precede the dry sound in the output. If the envelope is enabled, it 
is shown as a blue shaded region depicting the attack, hold, and release 
segments, shown below. The levels of the display components respond to the 
wet mix and late mix controls. The zoom controls in the upper right scale the 
time axis. 
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2.3 Damping EQ displays 
 

 
 
 

Label Description 

 
This control point changes the frequency and gain of the low band. 

 
This control point changes the gain of the mid band. 

 
This control point changes the frequency and gain of the high 
band. 

 
Both early and late damping EQs function as a low and high shelving filter 
relative to a mid-band gain. The early EQ sets the EQ for the reverb, while 
the late EQ scales the reverb decay times as a function of frequency. 

2.4 Frequency response 
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The frequency response visualizes the time-frequency decay shape of the 
reverb. The contour at time 0 is determined by the early EQ shape. The 
decay slope at each frequency is determined by the late EQ shape. 
 
Note that the frequency axis is flipped with respect to the EQ displays, with 
high frequencies at the left and low frequencies to the right. This is done 
because natural reverb decays slower at low frequencies and faster at high 
frequencies, so plotting this way yields a fully visible surface for typical 
reverbs. 
 

2.5 Early reflection controls 
 

 
 
 
Parameter Description 

Relection 
Type 

Sets the pattern of (stereo) early reflections. There are different 
choices, each determined by analyzing an existing room/reverb 
response. You can also select “Anechoic” which disables the 
early reflections, in which case you’ll hear the initial reflections 
inherent in the late algorithm. 

Diffusion Sets the amount of diffusion applied to the early reflections. 

Size The size parameter scales the timeline, larger sizes spread out 
the reflections, smaller sizes compress them. 

Dry Delay Delays the dry signal prior to the wet/dry mix. Delaying the dry 
signal is useful when creating reverse reverb effects where the 
reverb precedes the foreground (dry) sound. 

 

Set time or beat synchronization mode for the delay. See below 
section on beat synchronization. 

 

2.6 Beat synchronization 
 
There are beat synchronization controls in the early reflection, late reverb, 
and envelope sections. The controls determine whether the corresponding 
times are set in milliseconds (clock mode) or in beats (beat mode). 
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Control Description 

 

Sets clock mode. The corresponding time will be specified in 
milliseconds. 

 

Sets beat synchronization mode. The time will be determined 
based on the BPM (beats per minute) tempo of the DAW’s 
transport. The note value on the button indicates the duration; 
the quarter note shown at left is one beat, hence at 120 BPM 
this would be 500 msec. SHIFT/right-click on the button to 
select different note values via a popup menu. When beat mode 
is selected the corresponding time knob becomes a scale control 
that can be used to further adjust the time. 

 

2.7 Late reverb controls 
 

 
 
 
Parameter Description 

Reverb 
Type 

Sets the late reverb algorithm, either Hall or Plate. The hall 
algorithm emulates a large acoustic space, it can be scaled to 
emulate rooms of different sizes. The plate algorithm emulates a 
plate reverberator which is characterized by a rapid and dense 
echo buildup. 

Time Sets the 60 dB decay time of the reverberator. 

Size The size parameter scales the delays in the reverberation 
algorithm. This has a predictable effect with the hall algorithm, 
changing it to different room sizes. Scaling the plate algorithm 
has less effect. 

Wet Delay Delays the wet signal prior to the wet/dry mix. This is typically 
called “Pre-delay.” Delaying the wet signal can increase the 
audibility of the reverb and also create an echo effect. 

 

Set time or beat synchronization mode for the delay. See section 
on beat synchronization. 
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2.8 Output controls 
 

 
 
 

Label Description 

 

Lock the output controls. Enabling this locks the values of Wet 
Mix, Width, and Gain, so the current values persist as you step 
through presets. This is useful if you place MV7 on an effect 
bus and set Wet Mix to 100%, you can then lock output and 
step through presets and the Wet Mix stays at 100%. Locking 
has no effect on loading session state from DAW. 

 
Peak output levels, will show red if clipped. Click to reset. 

 
Stereo output meters with peak hold indicators. 

Late Mix This sets the mix of early reflections and late reverb. 0% 
means all early, 100% means all late. 

Wet Mix The sets the mix of dry input signal and wet reverb signal. The 
wet signal includes early reflections and late reverb. 0% 
means all dry, 100% means all wet. 
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Width Stereo width control. 0% will mix output to mono, 100% has 
no effect (stereo), > 100% will widen the stereo reverb, 200% 
(max) will drive stereo outputs out of phase. Settings over 
100% should be used judiciously. 

Gain Output gain in dB. 

 

2.9 Envelope 
 
The envelope processor modulates the reverb signal, providing a way to 
achieve gated and reverse reverb effects. The envelope is triggered when the 
input exceeds threshold. The envelope grows to full amplitude during the 
attack section, then holds for a certain time, and finally releases. The shape 
of the envelope is specified by attack, hold, and release times. 
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Label Description 

 
Envelope enable button. When the envelope is enabled, the 
output of the envelope modulates the reverb, so reverb is 
muted until the envelope triggers. 

 
Input meter. 

 
Envelope output meter shows the current level of the 
envelope. 

 
Input threshold slider mirrors the threshold knob. 

Thresh Sets the input level that must be exceeded for the envelope to 
trigger. 

Attack Sets the attack time of the envelope, the time to go from -inf 
dB to 0 dB. 

Hold After attack, the envelope will stay at 0 dB for the hold time 
before starting the release segment. 

Release Sets the release time of the envelope, the time to decay 60 
dB. When releasing, the envelope will retrigger if the input 
signal falls below threshold (minus a small margin) and then 
rises above threshold.  

 
Set time or beat synchronization mode for the envelope times. 
See section on beat synchronization. 

 

2.10 Ducking compressor 
 
The ducker attenuates the reverb during loud foreground sounds, thus 
preventing the reverb from muddying the foreground, and increasing clarity. 
This is beneficial for both voice and instrument sounds. 
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Label Description 

 
Ducker enable button. When the ducker is enabled, the wet 
reverb signal is ducked when the dry signal exceeds threshold. 

 
Ducker attenuation meter. The meter range can be changed in 
the preferences. 

 
Ducker input meter, shows the level of the dry input signal. 

 
Input threshold slider mirrors the threshold knob. 

Thresh Sets the input level that must be exceeded for the ducker to 
begin attenuating. 

Attack Sets the attack time constant of the ducker, how quickly it 
reduces gain. 

Ratio Sets the amount of ducking. 

Release Sets the release time constant of the ducker, how quickly gain 
is restored after signal falls below threshold. 

 

2.11 Modulation 
 
The reverb algorithms in MasterVerb employ slow frequency modulation to 
smooth the sound of the response. Without any modulation the tail of the 
response can sound resonant and metallic, with too much modulation the 
response can sound swooshy. Because the tradeoff depends on the sound 
being processed, some users may find it useful to adjust the default 
modulation settings. 
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Parameter Description 

Rate Sets the modulator LFO rate in Hz. 

Depth Sets the amount of frequency modulation. 
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3. Detailed Description of MasterVerb 

3.1 Audio routing 

MasterVerb's audio routing and meter placement is shown in the diagram 
below: 

 
 

MasterVerb 7 audio routing diagram. 
 
The input signal is split into wet and dry paths. The wet path is delayed by 
the wet delay (also known as pre-delay) and is then processed by the early 
damping equalizer. The wet signal is then split into early and late paths; the 
early path is processed with the early reflection generator, while the late 
path is processed by the late reverb. Note that the late damping equalizer is 
embedded in the late reverb algorithm. The early and late reverb 
components are mixed and fed into the envelope processor. The envelope 
processor is triggered by the non-delayed dry input signal. The output of the 
envelope processor feeds the ducking compressor. The side-chain of the 
ducker also comes from the non-delayed dry input signal. The final wet signal 
is mixed with the delayed dry signal and the result is processed by the final 
output gain. 

3.2 About reverberation 
 
When an object in a room produces a sound, a soundwave expands outward 
from the source reaching walls and other objects where sound energy is both 
absorbed and reflected. Assuming a direct path exists between the source 
and the listener, the listener will first hear the direct sound, followed by 
reflections off nearby surfaces, called early reflections. After a few tenths of a 
second, the number of reflected waves becomes very large, and the resulting 
reverberation is characterized by a dense collection of soundwaves traveling 
in all directions, called diffuse reverberation. 
 
The time required for the reverberation to decay 60 dB below the initial level 
is defined as the reverberation time. Generally, reverberation in a small room 
decays much faster than reverberation in a large room, because in a small 
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room the soundwaves collide with walls much more frequently, and thus are 
absorbed more quickly, than in a large room. 
 
Reverberation is an important acoustic phenomenon. There is at most one 
direct path from the source to the listener, whereas there may be millions of 
indirect paths, particularly in a room where a sound can bounce around 
hundreds of times before being absorbed. Thus, in typical listening situations, 
most of the energy we hear from a sound source is reverberation. 

3.3 Perception of reverberation 
 
The perception of reverberation depends on the type of reverberation and the 
type of sound. In small room with fast decaying reverberation, the 
reverberation imparts a tonal quality to the sound that is readily identified as 
a small room signature. In a larger room, the reverberation can create a 
background ambience that is easily distinguished from the foreground sound, 
and this is readily identified as a characteristic of large spaces. In this 
manner, reverberation imparts useful spatial information about the size of 
the surrounding space. 
 
Early reflections arriving within the first 80 msec after the direct sound tend 
to become perceptually fused with the direct sound. Hence the early 
reflections modify the character of the sound itself whereas much later 
reverberation becomes associated with the background ambience. A 
prominent reflection that occurs soon after the direct sound will create a 
comb filtering effect, as frequencies are either amplified or attenuated due to 
the reinforcement or cancellation caused by adding the delayed reflection to 
the direct sound. This comb filtering effect happens with any reflection, but is 
most noticeable with very early reflections which cause broad frequency 
effects. The result is a timbre modification of the sound, possibly hollow 
sounding, which can readily be associated with an enclosed space or a small 
room. 
 
Early reflections can also modify the apparent size of the sound source. 
Reflections that arrive in staggered order from the left and right directions 
confuse our sound localization perception. Instead of perceiving a narrowly 
localized sound source, the result will be a fuzzier, wider perception. Hence 
the early reflection pattern can affect both the timbre and apparent size of 
the source. 
 
Reverberation that contains a lot of high frequency energy in the decay is 
associated with rooms that have hard, reflective walls, which do not readily 
absorb high frequencies. Similarly, reverberation that is dull sounding is 
associated with rooms that contain soft materials, such as plush carpets and 
drapes, which readily absorb high frequencies. In this manner, reverberation 
imparts useful information about the composition of the surrounding space. 
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Reverberation is also important for establishing distance cues. In a 
reverberant space, when the distance between the source and the listener is 
increased, the level of the direct sound decreases considerably, but the level 
of reverberation does not decrease much. Thus, the level of direct to 
reverberant sound can be used as a distance cue, with dry (non-reverberant) 
sounds perceived as being close, and reverberant sounds perceived as being 
distant. 
 
Reverberation gives information about the size and character of the 
surrounding space and the distance of the sound source. For recordings that 
are made with close microphone techniques, artificial reverberation must be 
added to restore spatial context. Reverb is thus an essential tool for 
imparting a sense of space to your recordings. 

3.4 Reverberation algorithms 
 
Before digital reverbs were available, recording studios had to use other 
means to generate reverberation. One method required building a very 
reverberant room into which speakers and microphones were placed. Sounds 
to be reverberated were piped into the room, and the resulting reverb was 
picked up by the microphones. These rooms were known as reverb 
chambers.  
 
An alternative method of generating artificial reverb that requires much less 
space than a chamber is the plate reverb. Essentially the reverb chamber is 
replaced by a suspended steel plate. Signals are injected into the plate using 
transducers mounted on the plate, causing the plate to vibrate. The resulting 
vibrations are picked up by additional transducers mounted on the plate. The 
reverberation created by a plate is quite dense and diffuse. Although a 
plate’s reverberation doesn’t sound like a room’s reverberation, the sound is 
pleasing and often used on vocals and drums. 
 
Digital reverbs model acoustical and mechanical reverbs using a large 
number of delay lines through which the signal is recirculated. Each reverb 
algorithm has its own characteristic sound and idiosyncrasies. MasterVerb 
contains two reverb algorithms, the Hall and Plate algorithms. The Hall 
algorithm sounds like a concert hall. The Plate algorithm sounds like a plate 
reverb, characterized by a very rapid buildup of densely spaced reflections. 
 
The Hall algorithm can be scaled to sound like small rooms or very large 
spaces. Scaling a reverb algorithm is done by scaling the delays within the 
algorithm. The Plate algorithm can also be scaled but because the Plate 
response is so dense, the effect of scaling the Plate is less pronounced than 
scaling the Hall. 
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3.5 Early reflections 
 
MasterVerb models the early reflection pattern using a stereo tapped delay 
line. Each individual reflection is implemented with a single tap in the delay 
line. Typical reflection patterns may have 25 to 60 reflections per channel. 
The output of the tapped delay line is further processed by a diffuser circuit 
that smears out the response in time, causing the reflections to sound less 
discrete. 
  
The reflection patterns in MasterVerb are based on real and synthetic 
reverberation responses. Patterns are included for real acoustic spaces 
including halls, a cathedral, and some rooms, and for synthetic reverb 
responses including chambers and plates. 
 
The Anechoic reflection type has a single unit gain reflection at time 0 (in 
both left and right channels), so it simply passes the input signal unchanged 
to the diffuser circuit and onto the early plus late mixer. If late mix is set 
below 100% this will pass diffused dry signal into the wet path. To 
completely mute the early reflections set the late mix to 100%. 
 
The user should note that the CPU processing required for the early reflection 
generator is about the same as for the late reverb algorithm, hence if you 
need a really CPU efficient reverb, try bypassing the early reflection 
generator by selecting the “Anechoic” pattern, then set the late mix to 100%. 

3.6 Mixing with MasterVerb 
 
For music production, it is common to place a reverb plug-in on an aux bus in 
your host application program, and use the aux send on the tracks you want 
to be processed with reverb. In this case the reverb wet mix should be set to 
100%, therefore the aux return gain will set the wet level, and the track gain 
will set the dry level. Using reverb in this way not only saves CPU resources 
but lends to a more natural sound, since each track is in a sense sharing the 
same “space.” 
 
When placed on an aux bus, it’s also a good idea to enable the output lock 
parameter. When lock is enabled, preset changes made by the user will not 
affect the wet mix, width, and output gain parameters. So you can set wet 
mix to 100% and then step through presets and the wet mix will stay at 
100%. 
 
When using reverb as an insert effect, you will want to use much drier mix 
levels to prevent the sound from becoming too muddy with reverb. The 
presets are designed assuming the reverb will be used as an insert effect, so 
the preset mix levels are a good place to start. 
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3.7 Parameters 
 
This section describes all the internal parameters of MasterVerb 7 as would 
be displayed by a generic parameter-value plug-in interface. Most of these 
have a one-to-one correspondence with controls on the user interface. 
 
 
Parameter name Values 
Bypass 0 = Off, 1 = On 

Reflection Type 0 = Bypass, 1 = Hall1, 2 = Hall2, 3 = 
Cathedral, 4 = Room1, 5 = Room2, 6 
= Chamber1, 7 = Chamber2, 8 = 
Plate1, 9 = Plate2, 10 = Echo, 11 = 
Ping-pong 

Reflection Size x0.5 to x1.5 

Early Damping Lo Freq 20 to 640 Hz 

Early Damping Lo Gain -24 to 0 dB 

Early Damping Mid 
Gain 

-24 to 0 dB 

Early Damping Hi Freq 640 to 20,000 Hz 

Early Damping Hi Gain -24 to 0 dB 

Late Reverb Type 0 = Hall, 1 = Plate 

Late Reverb Decay 
Time 

0.5 to 60 sec 

Late Reverb Size x0.5 to x1.5 

Late Damping Lo Freq 20 to 640 Hz 

Late Damping Lo Scale x0.25 to x4 

Late Damping Mid 
Scale 

x0.25 to x4 

Late Damping Hi Freq 640 to 20,000 Hz 

Late Damping Hi Scale x0.25 to x4 

Envelope Enable 0 = Off, 1 = On 

Envelope Thresh -72 to 0 dB 

Envelope Attack Time 1 to 2000 msec 

Envelope Attack Scale x0 to x2 

Envelope Hold Time 1 to 2000 msec 
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Envelope Hold Scale x0 to x2 

Envelope Release Time 1 to 2000 msec 

Envelope Release 
Scale 

x0 to x2 

Envelope Sync 0 = Time, 1 = Whole note, 2 = Half 
note, 3 = Quarter note, 4 = Eighth 
note, 5 = Sixteenth note 

Ducker Enable 0 = Off, 1 = On 

Ducker Thresh -72 to 0 dB 

Ducker Ratio 1:1 to 50:1 

Ducker Attack 0.1 to 1000 msec 

Ducker Release 1 to 1000 msec 

Dry Delay 0 to 500 msec 

Dry Delay Sync 0 = Time, 1 = Whole note, 2 = Half 
note, 3 = Quarter note, 4 = Eighth 
note, 5 = Sixteenth note 

Dry Delay Scale x0 to x2 

Wet Delay 0 to 500 msec 

Wet Delay Sync 0 = Time, 1 = Whole note, 2 = Half 
note, 3 = Quarter note, 4 = Eighth 
note, 5 = Sixteenth note 

Wet Delay Scale x0 to x2 

Wet Mix 0% to 100% 

Late Mix 0% to 100% 

Output Gain -24 to 24 dB 

Diffusion 0% to 100% 

Modulation Rate 0 to 10 Hz 

Modulation Depth 0% to 100% 

Width 0 to 1.0: 0 = mono, 0.5 = stereo, 1.0 
= max 
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4. Installation and Registration 
 

4.1 Installation 
 
Installers for MasterVerb are found on the downloads page of the Wave Arts 
website. There are separate installers for Mac and Windows. Mac installers 
are “.dmg” files which after downloading will expand into a “.pkg” installer 
file; double-click on the “.pkg” file to launch the installer. Windows installers 
are “.exe” files; double-click on the “.exe” file to launch the installer. The 
installers provide various options for selecting which plug-in formats to install 
and whether to use Pace/iLok or Wave Arts licensing. 
 

4.2 Registration 
 
We support two licensing methods – Wave Arts licensing and PACE/iLok. 
When installing the plug-ins you must select which version of the plug-ins 
you wish to use. When you purchase a plug-in, you will be e-mailed a serial 
number (looks like WA-PPP-XXXX-XXXX where PPP is a product code and X is 
a hex digit). Use the serial number to unlock the plug-in as described below. 
 

4.3 Wave Arts licensing 
 
Prior to registration, the plug-ins operate in demonstration mode; they are 
fully functional but stop operating after 30 days. To unlock the plug-in after 
purchasing, open the plug-in, select the Tools->Register option, and enter 
your name, email address, and serial number. The plug-in will contact our 
registration server and download a license file which will unlock the plug-in. 
You should see a message saying your registration was successful. 
 
If your computer is not connected to the internet, use the Tools->Offline 
Register option and follow the instructions to generate a keyfile at our 
website registration page and import the keyfile. 
  
If you have purchased a plug-in suite, when you unlock any one of the plug-
ins within the suite, the entire suite will be unlocked. 
 

4.4 PACE/iLok licensing 
 
All our plug-ins support PACE/iLok. Prior to activation, the plug-ins will allow 
you to start a 30-day trial by creating an iLok account. To unlock the plug-in 
after purchasing, go to our Product Registration page, select “PACE/iLok”, 
and enter your serial number. A PACE redeem code (looks like XXXX-XXXX-
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XXXX-XXXX-XXXX-XXXX-XXXX-XX) will be displayed and also emailed to you. 
There are two ways to redeem the code and generate a license. When 
opening the plug-in a dialog window will appear and give you the option to 
Activate the plug-in, you can paste the PACE redeem code there, and 
proceed to create or login to an iLok account and then transfer the license to 
an iLok or your machine. Otherwise, go to http://www.ilok.com, create an 
iLok account, and download and install the iLok License Manager. Within the 
manager, under the Licenses menu, select “Redeem Activation Code” and 
paste your redeem code. Then transfer the license to either an iLok dongle or 
your machine. The plug-in will run only if it can find a license on an iLok or 
the machine. 
 
When purchasing a plug-in suite, the redeem code will generate multiple 
licenses, one per plug-in in the suite, but the licenses are grouped together. 
 
 

  



   

24 
 

5. Plug-in Control Operation 

5.1 Knobs 
 

 
 
Please refer to the following guide for information about the various ways 
you can use knobs: 
 
Function Mac Windows 

Increase/Decrease a parameter value 
(rotate clockwise/counterclockwise) 

Click on the knob + 
drag up/down 

-or- 

Mousewheel  

Click on the knob + 
drag up/down 

-or- 

Mousewheel 

Fine adjustment — increase/decrease Shift + click + drag 
up/down 

-or- 

Command + click + 
drag up/down 

Right click + drag 
up/down 

-or- 
Shift + click + drag 

up/down 

-or- 

Control + click + 
drag up/down 

Reset knob to default value Double-click Double-click 
 
By default knobs follow up/down mouse motion, but this can be changed in 
the preferences settings. 

5.2 Text Entry 
  

 
 
Many value displays are editable text. A text field is editable if your mouse 
cursor changes to an I-beam when moved over the text. Following is a table 
that fully describes how to use the text editing features: 
 
Function Mac Windows 
Enter text entry mode Click in the display Click in the display 
Select text  Click + drag Click + drag 
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Select entire text  Double-click Double-click 
Delete character to left of cursor Delete Backspace 
Delete character to right of cursor Fn+Delete Delete 
Move the cursor left/right Left/Right arrow 

keys 
Left/Right arrow 

keys 
Extend the current selection Shift + click + drag 

-or- 
Shift + left/right 

arrow keys 

Shift + click + drag 
-or- 

Shift + left/right 
arrow keys 

Exit text entry mode ESC 
-or- 

Return/Enter 
-or- 

Click on panel 

ESC 
-or- 

Return/Enter 

-or- 
Click on panel 

Select next parameter to edit Tab Tab 
Select previous parameter to edit Shift + Tab Shift + Tab 
 
 
You'll find that many parameters, such as frequency, will recognize units 
typed into the text field. The following values, when typed into a frequency 
value box, are equivalent: 
 

2k = 2 kHz = 2000 = 2000 Hz 
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6. Menu Bar and Preset Manager 
 
 

 
 
This section describes the operation of the menu bar, preset manager, and 
the other functions available in the menus. 

6.1 Enable 
 
The enable button looks like a power button. When lit the plug-in is enabled, 
and when unlit the plug-in is bypassed – it passes audio but without 
modification.  

6.2 Undo/Redo 
 
Clicking the Undo button causes the parameters and view options to revert to 
their settings prior to the last edit. The undo stack is unlimited, so you can 
keep clicking and revert back to the settings when the plug was initially 
opened. Clicking Redo restores the last undo. You can continue to redo back 
to the settings before undo was first used. However, if you make any edits 
the redo stack is discarded. 
 
The A and B buffers (described below) have independent undo/redo stacks. 
The undo/redo stacks store all parameters and many of the UI view options. 
Plug-in preferences are not stored in the undo/redo stacks. 

6.3 Preset name and arrow controls 
 
The currently selected preset name is displayed in the text field in the menu 
bar. Changing any parameters causes an asterisk (*) to be displayed at the 
end of the name. This indicates that changes have been made to the preset. 
In order to save the changes to a user preset you must select the “Save…” 
item in the Preset menu, described below.  
 
The arrow controls to the left and right of the preset name cycle through the 
set of factory and user presets. Clicking the right arrow goes to the next 
preset, clicking the left arrow goes to the previous preset. 

6.4 Preset menu 
 
The Preset menu contains lists of factory and user presets for easy selection, 
and options for managing presets. The functions are described in the 
following sections. 
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6.4.1 Factory Presets 
 
Factory presets are selected from a rolloff menu at the top of the Preset 
menu. Factory presets cannot be modified or deleted. 

6.4.2 User Presets 
 
User presets are selected from a rolloff menu just below the Factory presets 
in the Preset menu. When you first run a Wave Arts plug-in, there will not be 
any user presets and the menu will be empty. When you save a preset using 
the “Save” option the preset is added to the User menu. All instances of a 
plug-in share the same set of user presets. So, after you save a preset with 
one instance of a plug-in, you can go to another instance and find that the 
preset can be found in its User preset menu too. 
 
User presets are stored in an XML format file called “<plugin> Presets.xml”, 
where <plugin> is the name of the plug-in you are using. If the file is 
deleted, an empty preset file will be created automatically the next time the 
plug-in runs. User presets files are stored in the following directory, 
depending on the operating system, where <username> is your login name: 
 
Mac OS-X: 
/home/<username>/Library/Application Support/Wave Arts/<plugin>/ 
 
Windows: 
C:/Users/<username>/AppData/Roaming/Wave Arts/<plugin>/ 

6.4.3 Save As… 
 
When you have created an effect you want to save as a preset, select the 
“Save As…” option. You will be asked to name the preset and the preset will 
be saved in the set of User presets. If you supply the same name as an 
existing user preset, the existing preset will be either be overwritten with the 
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new preset or the new preset will be given a unique name, based on the 
setting of the “Overwrite duplicate names” option. 

6.4.4 Save 
 
The Save option is used to save changes to a user preset. The Save option is 
enabled when the current preset is a user preset and you have made 
changes, in which case an asterisk (*) will be appended to the preset name. 
Select the Save option to save the changes to the preset.  

6.4.5 Import Legacy 
 
Import legacy will find any user preset files from earlier versions of the same 
plug-in and will display them in a rolloff menu. Selecting a preset file will 
import the presets into the current user presets, converting the legacy 
presets to the current version. 

6.4.5 Import… 
 
User presets can be written to files using the “Export” function, and read 
from files using the “Import” function. Selecting the “Import…” option will 
open a file chooser to select the preset file for importing. After selecting the 
file the presets are read and will appear in the User Presets menu. 
 
Duplicate preset names are handled according to the “Overwrite duplicate 
presets” setting. 
 
Import can be used to import presets from an earlier version of the plug-in; 
the preset parameters will be converted to the current version of the plug-in. 

6.4.6 Export… 
 
Selecting the “Export…” option will open a file chooser to specify the output 
file. Then your user presets are written to the file. 
  
Preset Export is also useful for making backup copies of your user presets. If 
you have a large set of user presets, be sure to export them to a backup file. 

6.4.7 User Preset Manager 
 
The User Preset Manager provides a simple interface to organize user 
presets. You can rename presets, delete presets, and organize them by 
moving them up/down in the list. You can select multiple items at once to 
delete or move. Select OK to accept the changes, or select Cancel or close 
the window to abort without making any changes. 
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6.4.7 Overwrite duplicate names 
 
If this option is selected, then when you save a preset using “Save As…” 
using the same name as an existing preset, or when you import a preset with 
the same name, the existing preset is deleted and replaced with the new 
preset. If the overwrite option is not select, the duplicate preset name is 
handled by renaming the new preset, appending “(Copy)”, “(Copy 1)”, 
“(Copy 2)”, etc. as needed to avoid a duplicate name. 

6.5 A/B buffers 
 
The A/B edit buffers allow you to compare two different sets of parameters or 
presets. One of the A or B indicators is always lit; the one that is lit shows 
the current buffer. Clicking the A/B button will switch to using the other 
buffer, thus changing the effect settings (assuming different settings are 
stored in A and B). This is quite literally an A/B compare function. 
  
Once you have settings you like in buffer A, switch to buffer B and setup 
different settings, then click A/B to switch between the two. 

6.6 Copy buffer 
 
Clicking the Copy (arrow) button switches to the other buffer while also 
copying the buffer, hence the two buffers will be equal after the copy. The 
arrow points to the right when A is selected, and points left when B is 
selected. 
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Typical buffer use is: 
 

1) Get settings you like in buffer A. 
2) Copy to B, switching to buffer B. 
3) Further edit the settings in buffer B. 
4) Click A/B to compare the two buffers. 

 

6.7 Tools menu 
 
The Tools menu contains various important options, described below. 
 

 

6.7.1 Size 
 
The Size menu rolloff lets you change the interface size with one mouse 
gesture. After changing the size, clicking the plug-in title in the title bar will 
toggle between the last two selected sizes. Sizes that would be too large for 
the display are disabled. 

6.7.2 About… 
 
The About option displays important information about your plug-in. An 
example is shown below: 
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On the top line, the plug-in name and version are displayed, along with the 
current plug-in format (AAX, VST3, AU), bit depth, and CPU architecture. 
This is useful to determine which format of the plug you are running. The 
build date of the plug-in is displayed on the next line. If the plug-in is using 
Wave Arts licensing, the registration status is displayed on the next line. If 
the plug-in is operating in demo mode, the time remaining (if any) is 
displayed. If the plug-in has been successfully registered (unlocked), the 
serial number is displayed. If the plug-in is using Pace/iLok licensing, it will 
display “Pace/iLok licensing”. 

6.7.3 Register… 
 
Select this option to register (unlock) your plug-in. Enter your name, email 
address, and serial number, and click OK. This option is not available if using 
Pace/iLok licensing. 
 

 
 

6.7.4 Offline Register… 
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Select this option to register the plug-in when your computer is not 
connected to the internet. This option is not available if using Pace/iLok 
licensing. 

6.7.5 Unregister… 
 
Select this option if you no longer need to use the plug-in on this machine. 
The license file will be deleted and the serial number usage count will be 
decremented, allowing you to register on another machine. After confirming, 
the plug-in will revert to an unlicensed state, either bypassed or demo mode. 
The unregister option requires an internet connection. This option is not 
available if using Pace/iLok licensing. 

6.7.6 Open User Manual… 
 
Select this option to open this user manual in a browser.  

6.7.7 Preferences… 
 
This option opens the Preferences dialog to customize the plug-in operation. 
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Trademark Notices 
 

 
 

VST is a trademark of Steinberg Media Technologies GmbH 
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Support 
 
For assistance, please send email to: 
 

support@wavearts.com 
 
If you are having problems with a plug-in, please include the following information: 
plug-in name, operating system, and host software you are using. The version 
numbers are also helpful. 
 
For software updates, revision history, frequently asked questions (FAQ), and more, 
please visit our website at: 
 

www.wavearts.com 
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